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Welcome!

Welcome to King of Solitaire, the most comprehensive Macintosh solitaire
game on the market. King of Solitaire plays over 100 different solitaire games,
and includes a buili-in game editor that lets you change any rule in most games
and even add many of your own Solitaire favorites.

Requirements

King of Solitaire will run on any Macintosh, color or black and white, with
System 6.0.3 or later, including the Power Macintoshes.

The black-and-white version of the game requires S00K of free
memeory; the 256-color version requires 1400K. (The program will also run
with your monitor set to a higher number of colors, but will require a good bt
more memory to do so, and the graphics don’t get any better). King of
Solitaire’s “factory setting” is 1400K, so that you can play the color version. If
your Macintosh is a black-and-white-only machine, make the following change
before you start the game: in the Finder, select the King of Solitaire icon by
clicking on it. Choose Get Info from the File menu (Command-1). In the bottom
of the window that appears, you should see a box labeled “Current Size” or
“preferred Size.” Replace the figure you see there with 500K, and click the
close box in the window.

Getting Started

Installing King of Solitaire

While you can play King of Solitaire directly off the floppy disk, we do suggest
that you copy the game onto your hard drive. To do so, create a new folder for
the game and drag the King of Solitaire icon from the floppy to the folder on
your hard dnive.

Starting Up The Program

As always, 1o start the program, double-click its icon. The game will take a
moment to load, and then will show you the King of Solitaire. Click the mouse
button to continue, and you'll be presented with a blank screen.

The Game Screen
At the top of the screen is the status line. The left half of this line displays




messages as you play— for example, if you move a card to a pile where it can’t
be placed, King of Solitaire will give you a brief explanation of the rule. (For
all of the rules of a game, choose “Instructions™ from the File menu after
dealing out a hand).

On the right side of the status line are several other boxes. The Score
box gives you your total score. The Redeals box tells you how many “redeals”
you have (see below). The Foundations box tells you what rank of card (Ace
through King) must be the first placed on an empty foundation pile (see below
for an explanation of these terms).

The Games Menu

All of the games that King of Solitaire can play are in the Games menu. They
are organized in groups of similar games, called “sets.” Within those groups,
some games start with a “-” to indicate that they are variants of the game that
precedes them. For example, Yukon is a variant of Klondike— almost the same
game, but with a few different rules. Sometimes the variants are easier versions
of the main game; other times, the variants have more unusual rules.

Some of the games are listed in italics. This means that this game has
unusual rules that had to be hard-coded into the game. The Game Editor, which
allows you to change game rules, will not work as effectively with these games.

To play a game, click and hold the mouse button on the Games menu,
drag down to the category you're interested in, then choose a game from the
menu that pops up. King of Solitaire will deal the cards, and you're off.
(Because so many people have asked, the most familiar Solitaire game, which
also happens to be one of the least interesting, is called “Klondike™ in King of
Solitaire).

Road Map— The rest of this documentation is organized as follows:

Playing the Games, reviews basic Solitaire terminology and game
mechanics— how you deal, move cards, etc.

Preferences, tells you about the many ways in which you can customize King
of Solitaire, including changing the background pattern, scoring options,
automatic card movement, and other options.

Tournament Play, explains King of Solitaire’s options for playing
competitively.

The Editor, explains how King of Solitaire's powerful editor permits you to
change game rules and even “teach” King of Solitaire how to play new games.
Choosing A Game, gives some information about the various games,
highlighting a few that give real opportunities for strategic play, and some that
are purely automatic, so that you can find games you like.

Parting Shots, tells you how to learn about Artworx” other great Mac games
and how to contact King of Solitaire’s programmer.



Playing the Games

Terminology: Most solitaire games consist of laying out different piles of
cards. Different piles have different functions in the games, and distinct names
that King of Solitaire uses to describe them: foundation, tableau, reserve,
stock, and waste.

First, in almost all of the games, the object is to get all of the cards in
order onto piles called the foundations. Placing a card on a pile is called
building on that pile.

Cards are generally built on the foundations by moving them from
other piles, usually the tableau piles, which in most games are the principal
“play space”™: that is, you're generally moving cards onto the tableau and then
off the tableau to the foundations.

Some games also have one or more reserve piles, which are like
tableau piles with one important difference: no cards may ever be built on
reserve piles. They often hold cards “in reserve” that you can play to other piles
when you get stuck.

The stock is the name of the pile that holds the deck, and the waste
piles are usually discard piles, where any card can be placed.

Building: The rules for building cards vary widely from game to game, and
different piles may have different build rules. There are two categories of rules:
suit and sequence.

Suit—  Piles are built in one of five ways with respect to suit:

(a) in suit (e.g., Spades may only be built on Spades);

(b} in color (red cards on red and black on black);

(c) regardless of suit;

(d) in alternating colors (red on black and vice versa); and

(e) on any suit but its own (e.g., Spades may be built on Hearts,

Diamonds, or Clubs, but not Spades).
Sequence— With respect to sequence, cards may be built up, from Ace to King,
down, from King to Ace, in any order, or by intervals (up in an interval of
two, for example, means that Threes go on Aces and Kings go on Jacks). In
some games, ranking is continuous, which means that Aces are both high and
low: you can put an Ace on a King and a Deuce on an Ace.

To find out how cards are built on each pile in a particular game, select
the game from the Games menu, and afier the deal choose Instructions
{Command-1) from the File menu.

Playing: To turn over a card that is face down, click on it. To move a card to
another pile, click and drag it where you want it to go. You don’t have to place



it precisely on the pile. If the card can’t be built there, it will fly back where it
came from, and you’ll get a brief explanation on the status line at the top of the
screen. Otherwise, it will slide neatly into place. You can also make cards move
automatically by clicking on them (see Preferences, below).

Most of the time, you can undo moves by choosing Undo (Command-
Z) from the Edit menu. King of Solitaire keeps track of all of the moves you
make in a game, so you can undo all the way back to the starting position if you
wish.

In many games, you don’t deal out the entire deck at the beginning of
the game, but keep most of the deck in a pile (the stock). You then take cards
from the stock and try to place them on the tableau or the foundations. If you
can’t play them on these piles, there is generally a waste pile where they can
go. In many of these games, you're permitted to go through the stock more than
once, by gathering up the cards you couldn't play the first time around and
putting them back in the stock pile to go through again. This is called a redeal.
The number of redeals you're permitted is shown on the status line. To redeal,
click on the empty stock pile.

The color version of King of Solitaire comes with three decks of cards:
small, medium, and large. Ordinarily, when you choose a game, King of
Solitaire deals it out using the largest cards that will fit on yvour screen. For
example, on a standard 640 x 480 monitor, Auld Lang Syne uses the largest
cards, Klondike uses medium cards, and Baker's Dozen uses the smallest cards.
To choose the smallest cards regardless of what will fit (they fly faster on the
screen on slower Macs), hold down the Option key before choosing a game
from the Games menu. You can also turn off big cards completely as described
below in “Preferences.”

Showing Legal Moves: Although some of the fun and skill of Solitaire is in
identifying all the possible moves, sometimes it’s nice to have someone point
them out to you. At any time during a game, you can choose “Show Legal
Moves” from the File menu, and King of Solitaire will blink the cards that can
be moved. Note that King of Solitaire doesn’t screen out bad moves; there's no
guarantee that a move King of Solitaire points out will be of any help. The
program just shows you the moves that are available. This is most useful at the
end of a game, when you think you're stuck.

High Scores: King of Solitaire keeps track of the top five scores in each
different kind of Solitaire. (If you use the Editor to create your own games, or
custom versions of existing games, King of Solitaire will keep track of scores
for those games, too). Because King of Solitaire has three different ways of
scoring, which aren’t really comparable (see below in Preferences), the
program keeps track of the top five scores for each method for each game.
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To see the high scores, choose “Show High Scores™ from the File
menu after dealing out a game. To view scores made using a different scoring
method, click on the popup menu and choose a different scoring method. (This
doesn't affect the scoring method used in the game; it just shows you the high
SCOTES ).

Preferences

The Preferences item in the File menu lets you customize several features of

King of Solitaire.

Automatic card movement: In the top left of the window is a set of buttons

labeled “Clicking a card without dragging.” These options permit aulomatic

card movement, which means you can just click on a card to move it, without
dragging it where you want it to go.

If the “Tries to fly card to foundations™ option is selected, each time
you click on a card without dragging King of Solitaire will check to see if it can
be moved to a foundation pile, and move it there automatically.

If the “Tries to find a legal move” box is checked, King of Solitaire
looks at all of the piles, and moves the card wherever it can. If there is more
than one pile where the card may be moved, King of Solitaire may not pick the
one you wanted; if that happens, choose Undo {Command-Z) from the Edit
menu and drag the card where you want it to go.

Background Patterns: If you don't like King of Solitaire’s default
background, you can change it by clicking on one of the other patterns shown.
Just be sure the pattern you want is highlighted when you click "OK.” These
patterns are known as “pixel patterns.” or “ppats.” and are widely available on
online services like America Online, Compuserve, and GEnie. If you already
have some favorite ppats, you can import them into King of Solitaire by
clicking the Acqguire... button. Open the file containing the ppats you want to
import, and select them in the window that appears. You can choose more than
one by holding down the Shift key while you click. If there are patterns in King
of Solitaire that you don’t want, you can delete them by selecting the unwanted
pattern and clicking the Delete button. This is a permanent deletion, though, so
be careful. (On black-and-white Macs, only the built-in patterns are available,
and they can’t be deleted).

Scoring: King of Solitaire normally keeps score by counting the rank of the
cards you play on the foundations (Ace is | point, King is 13). In games that
build the foundations up from Ace to King, this method reflects the hard work
of completing a foundation pile. This is not always the best method, though, so
you can also choose to treat all cards the same: one point per card played on the
foundations.

Instead of scoring by points, you can also choose to have King of




Solitaire time you. This is a useful option for games that depend more on
strategy than the luck of the draw. For example, Baker's Dozen can almost
always be won with careful play, and you’ll find if you play for a while that
you can win the game every time. By setting King of Solitaire to a timed game,
you get some of the challenge back: now you not only want to win, but to do so
more quickly than before.

Use larger cards if possible: The medium and large card decks are much more
attractive and detailed, so King of Solitaire normally uses the biggest deck that
will fit on your screen for a particular game. The larger decks may display
slowly on older Macs, however, so you can choose always to use the small deck
by turning this option off.

Animate deal: King of Solitaire normally deals the cards out by flying them
from the stock to the appropriate piles. If you'd like to turn off the animation,
you can do so.

Confirm end of game: When you've been playing a game, and move on to
another one, or open the editor, King of Solitaire normally asks whether you're
sure you want to end the game. If you'd rather not see this reminder, you can
turn it off,

Tournament Play

Overview: Although Solitaire, as its name implies, is usually played by one
person, it can be played competitively as well. In King of Solitaire, up to four
players can play one or more Solitaire games, one after the other, to compete
for the highest score. Because many Solitaires have an element of luck, you can
choose to have everyone play with the same deck.

To play a tournament, first select Tournament Info. .. from the File
menu. That allows you to set player names and a few options. During a
tournament, you can select this item again to keep track of players’ scores. (All
of this is described in detail below in Tournament Info).

Once you've set up everyone's name, choose Tournament Play from
the File menu to begin the tournament, and then choose a Solitaire game from
the Games menu, as usual. The current player and the player’s score are
displayed on the status line. You can play one Solitaire several times, or as
many different games as you like. King of Solitaire will keep track of the scores
until you turn tournament play off by choosing it again from the File menu. You
can also start a new tournament by choosing Tournament Info... and resetting
everyone's score 1o zero.

Tournament Info: The Tournament Info... dialog box lets you set up a
tournament and keep track of players’ scores. To select it, choose Tournament
Info... from the File menu. Type in the names of the players in the boxes
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provided. The buttons to the left of the players’ names determine who will play
next; you can skip over players by choosing a different player’s name.

Below the players’ names, you may choose to shuffle the deck
between games, or to have all players use the same deck. Usually, you'll want
everyone lo play with the same deck (that is, without shuffling in between
players); that way, the role of luck is minimized, and the contest is more one of
skill.

NOTE: The ability to play a game repeatedly with the same deck is

also useful for one-player games. If you're trying to become proficient

at a particular game, for example, it may be fun to play it repeatedly
with the same deck, io seec how high you can run the score.

The final option, Check High Scores during tournament, lets yvou determine
whether King of Solitaire will check at the end of each player’s tum to see if
that player has a high score. That process can sometimes be annoying, 50 you
can turn off high score checking if you like.

The Editor

The Game Editor is a unique feature of King of Solitaire that allows you to
change the rules of any game in the program, and even create your own
Solitaire games from scratch.

Why would you want to do these things? First, Solitaire is centuries
old, and different people play the games in different ways. Do you turn over
three cards from the stock when you play Klondike, or just one? Do you let
yourself go through the deck as many times as you want, or do you limit
yourself to three? King of Solitaire lets you play the games the way you wani
to play them. Second, if you find a particular game too easy or (more likely)
too challenging, you can make the game more fun to play by adjusting the
rules. Third, in many cases, if King of Solitaire does not play one of your
favorite Solitaire games, you can “teach” the program how to play it. Of course,
Solitaire games are so varied that there are many that King of Solitaire can't
learn to play. But the Editor is very flexible. Here's how to use it.

Overview

There are two ways Lo get into the Editor. Either choose an existing game from
the Games menu, and after the deal is complete choose “Open Editor...” from
the Editor menu. You can also enter the Editor to create an entirely new game
from scratch, by choosing “Create New Game”™ from the Editor menu. Once
you've created a game or modified an existing one, you can delete it by
choosing Delete Custom Game. .. from the Editor menu.



NOTE: Games that appear in the Games menu in italics have unusual
rules that don’t follow King of Solitaire’s conventions. While they re
included here because they 're fun to play, they're less easy to edit. You
can always drag piles into new positions, as described below, but be
careful about changing other rules for these games.

The functions of the Editor are the same whether you start from scratch or edit
an existing game. Just remember, if you're creating a game from scratch you
must do the job completely, setting all four sets of characteristics described
below, or your game probably will not function as you expected.

Either way, when you enter the Editor, the screen appearance will
change. If you're editing an existing game, all of the game’s piles will appear
with their type (foundation, tableau, etc.) written on them. Also, a special
window will appear to provide easy access to Editor functions.

The Editor lets you adjust four categories of game characteristics:

a. the basic rules;

b. the card piles, including the number of piles, their position, and the
rules associated with them;

c. the rules of card movement, which determine whether cards from
one kind of pile can go on another kind of pile; and

d. how the cards are dealt.

Editing game rules: Every solitaire game obviously has a set of rules. To see

the rules of a particular game, choose “Edit *Game’ Rules” from the Editor

menu. {You can also click on the button in the Editor's floating window with an

icon of a rules sheet on it). A window appears that lets you set all of the basic

rules. Here's what those rules do:

1. Game Name:
You can change the name of a game if you like. If youre editing an
existing game, changing the name will ensure that your edited version
1s saved separately as a custom game, as though you'd created it from
scratch. The existing game won't be affected by your edits. If you're
creating a game from scratch, the name will start out “Untitled,” and
you'll want to choose a name.

2. General Rules:
Decks: You can choose to play the game with one or two decks.
Maoving cards: These options determine how cards may be moved
from piles that are not stacked in a heap, like the tableau piles in
Klondike. If you choose “Only top card is available,” only the last card
to be placed on the pile may be moved. If you choose “Rows/columns



must be moved as a unit,” then you may only move all of the face-up
cards as a group (by clicking on the bottom card). The next option,
“Any card may be clicked,” allows you to move any number of face-
up cards from the pile. The box underneath applies to games like
Spider, where cards may be built on the tableau regardless of suit, but
can only be moved if they're in suit.

3. Tableau Rules:
Must fill empty piles if possible: If this box is checked, King of
Solitaire will automatically fill an empty tableau pile with a card from
the stock as soon as the tableau pile becomes empty.
Tableau piles start with: This option determines the minimum rank
(Ace, Deuce, Three, etc.) required to start a tableau pile. For example,
in Klondike, you may only move a King to an empty pile. Click “Any
card” to remove this restriction, or type a key (A, a number, T (for
Tens), J, Q, or K) in the box to change the card that must start a
tableau pile.

4. Stock Rules:
When stock pile is clicked: This determines what happens when you
chck on the stock. The first option lets you specify the number of
cards that King of Solitaire should deal to the waste pile. The second
option indicates that King of Solitaire should executz a more
complicated deal; see Creating a New Game below.
Redeals: This option lets you determine how many times unplayable
cards may be collected from the waste piles to go through them again.
Deal to tableau: This option lets vou specify that when cards are
turned from the stock, they go to tableau piles instead of waste piles.
You generally shouldn’t need this option.

5. Foundation Rules:
Must fill empty pile if possible: This is the same as for the tableau rule,
described above. With this rule on, if a foundation is empty and a card
that could fill the space is available, King of Solitaire will move it
there automatically.
Must play if possible: If this option is checked, King of Solitaire will
automatically send a card to the foundation whenever it appears, if that
is a legal move. Some games require such a rule. In the computer
version of Solitaire, though, this is less fun, because it takes away
some of the challenge.
... but not if the reserve is empty: In some games that require you to
play available cards on the foundation, the rule changes once you have
exhausted the reserve piles.
Foundations start with: This is like the tableau rule, above, but it has a
few more options. If you choose “First card played there,” King of



Solitaire will wait until you play a card, any card, on an empty
foundation pile, and then that will become the rank necessary to start
the other foundation piles. The option “First card dealt there™ 1s used
when King of Solitaire deals a card to the foundations to start the
game, as in Canfield. If you choose the option “Varies by pile,” then
King of Solitaire looks to each pile to determine what card is
necessary. See “Editing Pile Rules,” below.

If you like the changes you’ve made, click OK: otherwise,
click Cancel.

Pile Editing: King of Solitaire also gives you broad control over the card
piles. You can create new piles either by choosing “Create Pile” from the Editor
menu, or by clicking on the kind of pile you want to create in the Editor’s
floating window and dragging the new pile where you want it to go. To delete
an existing pile, select it by clicking on it, and then either choose “Delete Pile™
from the Editor menu, or click on the eraser icon in the Editor’s floating
window.

To move a pile to another position, just click on it and drag it. Be
careful not to stack piles on top of one another. Also, if you intend to let cards
spread out from the pile, be sure to leave room so that when cards are spread
during play they won't cover another pile.

There are also rules associated with each pile in the game. To see these
rules, double-click on a pile. (The window also appears when you create a pile,
or when you select a pile and click on the icon under the eraser in the floating
window). These are the settings you can change for each pile:

Pile Type: This lets you determine whether a pile is a foundation, reserve,
tableau, stock, or waste pile. You should never have more than one stock pile.
In fact, it’s generally unwise to change the types of piles in existing games.
Card Placement: This option lets you choose to stack cards in a heap (like the
foundation piles in Klondike), or to spread the face-up cards (hke Klondike's
tableau piles). To change the direction the cards are spread, click on the pop-up
menu.

Building: These options let you change how cards are built on this pile. Cards
may never be built on reserve piles. To learn what these options mean, see
Building™” under “Playing the Games,” above. “Continuous ranking”™ here
means that Ace is both high and low: it may be played on a Deuce, but a King
may also be played on the Ace.

Starting Cards: If you're editing a foundation pile, you have one other option:
you may separately determine for each pile what rank of card is required to
starl an empty pile, as described above under “Tableau Rules.” If you choose
anything other than “Any card,” you need to be sure and set the starting card
for all of the foundation piles.
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Card Movement (Availability) Rules: The third major set of rules is the
availability rules. To change these, select Card Movement. .. from the Editor
menu, or click on the icon in the floating window that shows a card going to
two different empty piles.

In the dialog that appears, you may specify what piles are available to
which other piles. For example, in Klondike, tableau cards may be played on
the foundations, on other tableau piles, and on empty tableau piles. They cannot
be played on the stock or on the waste. When editing an existing game, you
generally should not change the availability rules; this option is mostly used
when creating a game from scratch.

Recording the Deal: The fourth major part of the Editor, which you’ll
generally only use in creating a new game, is the Deal Recorder. This feature
lets you tell King of Solitaire how to deal out the cards at the beginning of your
game. Choose Record Deal... from the Editor menu to get started.

NOTE: You should only choose Record Deal... after you have created
all of the piles your program needs, including a stock pile.

Before starting to record the deal, choose either “opening deal” or “when no
moves” in the Recorder dialog. If you choose “when no moves,” the deal you
record will not be used at the beginning of the game, but will be executed
instead of turning over cards from the stock. Also before starting the deal, you
can click the “Special Deal Rules” button to set two other features. If you check
the “Kings to bottom™ box, King of Solitaire will move all Kings to the bottom
of their respective piles after the deal is complete. (Baker’s Dozen, for example,
uses this option). You can also choose to have King of Solitaire deal the starting
card to each of the foundations by choosing “Before dealing, start all
foundations.” The other option, “Start foundations if possible,” will deal a
starting card to a foundation pile if it should turmn up during the deal. For
example, if foundations start with Aces, and an Ace turns up in the deal, King
of Solitaire will put it on an empty foundation instead of the pile it was headed
for.

When you've set these options, you're ready to record the deal. To
deal a card to a pile, click on the pile. King of Solitaire will deal a card there to
show you that it understands. (Don’t worry about what the card is; it will be
different when you actually play the game, of course, because King of Solitaire
shuffles the deck). While you're dealing, you may click on the “Deal cards face
up"” button as often as you like to switch back and forth between dealing cards
face down and face up.

When done recording, click OK, or Cancel to ignore your new deal.
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That’s the Game Editor. When you're finished making changes,
choose “Exit Editor” from the Editor menu. King of Solitaire will ask if you
want to save your changes. Remember that if you started with an existing
game, and haven't changed the name, saving your changes will change the
game that shipped with King of Solitaire. One more reason to store your
original game disk in a safe place!

Because Solitaire comes in so many diverse permutations, the Editor is
necessarily a little complex, but it gives you the power to play Solitaire the way

you enjoy it.

Choosing A Solitaire (Game

King of Solitaire offers so many games (over 100 in version 2.0), that it’s
sometimes difficult to locate the ones you most want to play.

The traditional Solitaire— the one that comes with that OTHER
operating system (Microsoft’s Windows 3.1) and that many people think of as
simply “Solitaire,” is actually called Klondike. Although most people know it,
it's actually one of the least interesting to play. The chances of winning are very
low— about 5%— and whether you win or lose depends almost entirely on the
luck of the deal.

But some Solitaire games leave real room for strategy— games that
can almost always be won, but only with careful, thoughtful play. If you're up
for a challenge, try some of these games:

Baker's Dozen
Beleaguered Castle
Bisley

Bristol

Colorado

Eight Off

Fortress

Golf

Good Measure
Grandfather's Clock
Shamrocks

Sly Fox

Spider

Slrategy

Terrace

Whitehead

Yukon



There are others that leave room for strategy; the above are some of

our favorites.

Sometimes, however, the fun of Solitaire is not in thinking, but in
spinning through a few mindless games. These can be the most relaxing. If
that’s what you're in the mood for, try the Addition games, especially Pyramid;
the Accordion games; the Clock games; the Patience games; or Royal Flush (in
the Miscellaneous set).

Finally, if you're in the mood for something unusual, try the games in
the Miscellaneous set. These are games that didn’t fit neatly into any other
category, and some of them are truly bizarre.

Parting Shots

We at Artworx sincerely hope you enjoy King of Solitaire, and welcome your
comments, either by phone at (800) 828-6573, or by mail to Artworx Software,
1844 Penfield Road. Penfield, NY 14526. Your registration card is a great way
1o send us your comments, features you'd like to see, games you wish were
included, anything.

You can also reach the programmer, Mark W. Batten, on America Online at
MarkBatten, or on the Internet at markbatten@aol.com, and he will try to get
back to you directly. Artworx can be reached at artworx@ frontiernet.net

Artworx carries other great games for the Macintosh and PC. Please call or
write for a catalog or visit our home page on the World Wide Web at:

htpp://www.frontiernet.net/~artworx
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